Virtual Infrastructure

Web Access Administrator’s Guide
Please note that you can always find the most up-to-date technical documentation on our Web site at http://www.vmware.com/support/.

The VMware Web site also provides the latest product updates.

Copyright © 1998-2006 VMware, Inc. All rights reserved. Protected by one or more of U.S. Patent Nos. 6,397,242, 6,496,847, 6,704,925, 6,711,672, 6,725,289, 6,735,601, 6,785,886, 6,789,156 and 6,795,966; patents pending. VMware, the VMware "boxes" logo and design, Virtual SMP and VMotion are registered trademarks or trademarks of VMware, Inc. in the United States and/or other jurisdictions. Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation. Linux is a registered trademark of Linus Torvalds. All other marks and names mentioned herein may be trademarks of their respective companies. Revision: yyyyymmdd Version: 2.5 Item: XXX-ENG-QNNN-NNN
View Menu 30
Inventory View Options 30
Virtual Machine Tab View Options 30
Virtual Machine Menu 31
Virtual Machine Power Options 31

The Toolbar _________________________________________________31
The Inventory Panel ___________________________________________32

Using Virtual Infrastructure Web Access to Manage Virtual Machines __ 35
The Summary, Events, Alarms, Tasks, and Console Views _______________36
Viewing Summary Information About Virtual Machines __________________37
Viewing Virtual Machine Events ____________________________________39
Viewing Virtual Machine Alarms ____________________________________40
Viewing Virtual Machine Tasks _____________________________________41
Using the Console ______________________________________________42
   Entering Full Screen Mode ______________________________________43
Installing VMware Tools in the Guest Operating System _________________44
   Installing VMware Tools ________________________________________44
Upgrading VMware Tools _______________________________________44
Changing the Power State of a Virtual Machine ________________________45
Creating and Sharing Remote Console URLs __________________________46

Editing an Existing Virtual Machine’s Configuration _______________________49
Editing the Configuration of Existing Virtual Machines ________________50
   Understanding Virtual Machine Power States ________________________50
   Understanding Permissions and Virtual Machines ____________________50
Editing the Hardware Configuration of a Virtual Machine ________________51
   Editing Processors ____________________________________________51
   Editing or Removing a CD/DVD Drive _____________________________52
   Editing or Removing a Floppy Drive ______________________________54
   Editing a SCSI Controller _______________________________________55
   Editing or Removing a Hard Disk _________________________________56
   Editing Memory Configuration __________________________________57
   Editing or Removing a Network Adapter ___________________________58
   Editing or Removing a Parallel Port ______________________________59
   Editing or Removing a Serial Port ________________________________60
Adding Hardware to a Virtual Machine _______________________________62
   Adding a Hard Disk _____________________________________________62
Preface

This preface describes the contents of this manual, lists related documentation, describes document conventions, and provides additional references for support. This preface contains the following topics:

- About This Guide on page 6
- Related Documentation on page 7
- Conventions on page 8
- Technical Support Resources on page 9
About This Guide

This manual, the Virtual Infrastructure Web Access Administrator’s Guide, provides information on how to configure virtual machines for ESX Server and VirtualCenter Server.

Intended Audience

The information presented in this manual is written for experienced system administrators who are familiar with Windows or Linux virtual machine technology and datacenter operations.

Document History

This is the RC version of the Virtual Infrastructure Web Access Administrator’s Guide.

This manual is revised with each release of the product or when deemed necessary. A revised version can contain minor or major changes.

<table>
<thead>
<tr>
<th>Release</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESX Server 3, RC release</td>
<td>April 20, 2006</td>
<td>PDF on the Web</td>
</tr>
</tbody>
</table>
Related Documentation

ESX Server 3 and VirtualCenter 2 documentation consists of the following publications:

- Documentation Roadmap
- Introduction to Virtual Infrastructure
- Installation and Upgrade Guide
- Server Configuration Guide
- Virtual Machine Backup Guide
- ESX Server and Microsoft Cluster Service Guide
- SAN Configuration Guide
- Resource Management Guide
- Setup for Microsoft Cluster Service
- Online help
- Hardware compatibility guides
  - I/O Compatibility Guide
  - SAN Compatibility Guide
  - Systems Compatibility Guide
  - Backup Software Compatibility Guide
- Release Notes
Conventions

This manual uses the following conventions.

<table>
<thead>
<tr>
<th>Style</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>blue (online only)</td>
<td>Cross references, links</td>
</tr>
<tr>
<td>Courier</td>
<td>Commands, filenames, directories, paths, user input</td>
</tr>
<tr>
<td>Semi-Bold</td>
<td>Interactive interface objects, keys, buttons</td>
</tr>
<tr>
<td>Bold</td>
<td>Items of highlighted interest, terms</td>
</tr>
<tr>
<td>Italic</td>
<td>Variables, parameters, emphasis in text</td>
</tr>
<tr>
<td>italic</td>
<td>Web addresses</td>
</tr>
</tbody>
</table>

Abbreviations

The graphics in this manual use the following abbreviations.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VC</td>
<td>VirtualCenter</td>
</tr>
<tr>
<td>VI</td>
<td>Virtual Infrastructure</td>
</tr>
<tr>
<td>server</td>
<td>&lt;product name&gt; server</td>
</tr>
<tr>
<td>database</td>
<td>&lt;product name&gt; database</td>
</tr>
<tr>
<td>hostn</td>
<td>&lt;product name&gt; managed hosts</td>
</tr>
<tr>
<td>VM#</td>
<td>Virtual machines on a managed host</td>
</tr>
<tr>
<td>user#</td>
<td>Users with access permissions</td>
</tr>
<tr>
<td>vmdk#</td>
<td>Storage disk for the managed host</td>
</tr>
<tr>
<td>datastore</td>
<td>Storage for the managed host</td>
</tr>
<tr>
<td>SAN</td>
<td>Storage area network type datastore shared between managed hosts</td>
</tr>
<tr>
<td>tmplt</td>
<td>Template</td>
</tr>
</tbody>
</table>
Technical Support Resources

The following sections describe various technical support resources available to you.

- **Self-Service Support**
- **Online and Telephone Support**
- **Support Offerings**

**Self-Service Support**

Use the VMware Technology Network for self help tools and technical information:

- Product Information — [www.vmware.com/support/resources](http://www.vmware.com/support/resources)
- Technology Information — [www.vmware.com/vcommunity/technology](http://www.vmware.com/vcommunity/technology)
- Documentation — [www.vmware.com/support/pubs](http://www.vmware.com/support/pubs)
- Knowledge Base — [www.vmware.com/support/kb](http://www.vmware.com/support/kb)
- Discussion Forums — [www.vmware.com/community](http://www.vmware.com/community)

For more information about the VMware Technology Network, go to [www.vmtn.net](http://www.vmtn.net).

**Online and Telephone Support**

Use online support to submit technical support requests, view your product and contract information, and register your products. Go to [www.vmware.com/support](http://www.vmware.com/support).

Use phone support for the fastest response on priority 1 issues for customers with appropriate support contracts. Go to [www.vmware.com/support/phone_support.html](http://www.vmware.com/support/phone_support.html).

**Support Offerings**

Find out how VMware’s support offerings can help you meet your business needs. Go to [www.vmware.com/support/services](http://www.vmware.com/support/services).
Introducing VMware Virtual Infrastructure Web Access

This chapter introduces Web Access components and operations. This chapter contains the following topics:

- What is Virtual Infrastructure Web Access? on page 12
- Key Features on page 13
What is Virtual Infrastructure Web Access?

VI Web Access is a browser-based application designed to manage virtual machines on ESX Server and VirtualCenter deployments. This version of VI Web Access focuses on virtual machine management, and pays particular attention to:

- System administrators needing to access virtual machines without a VI Client.
- People who use virtual machines as remote desktops.
- Virtual Infrastructure administrators who need to interact with virtual machines remotely.

The VI Web Access interface provides a powerful overview of all the virtual machines on an ESX Server system and VirtualCenter server. Using VMware Virtual Infrastructure Web Access to manage virtual machines, you can:

- View hosts and the virtual machine details using a Web browser.
- Perform power operations on virtual machines.
- Edit a virtual machine's configuration and hardware.
- Generate URL shortcuts that others can use to access virtual machines.
- Interact with the guest operating systems running within the virtual machines.

VI Web Access is focused on virtual machine management, and does not offer the full range of administrative tasks available through the VI Client.
Key Features

VI Web Access 1.0 RC is a preview of VMware’s browser-based virtual infrastructure management application. The key features of this preview release include the following:

Virtual Machine Management

Use VI Web Access to access virtual machine status information and power controls by connecting directly to an ESX Server host or a VirtualCenter server.

Use the mouse, keyboard, and screen, including full screen mode, of any virtual machine from any compatible Web browser.

Remote Virtual Machine Console URLs

Use VI Web Access to share virtual machines with customized controls and environments using ordinary web browser URLs.

Each URL provides direct access to a specific virtual machine from virtually any Web browser.

Usability

Administrators can provide end users access to virtual machines.

Users can access virtual machines on ESX Server hosts and VirtualCenter servers without having to install the Virtual Infrastructure client.

Client devices allow people to use floppy and CD/DVD drives from their own computers to install software or copy data without needing access to the drives on their ESX Server hosts.

Simplified Remote Console Use

Bookmarks can be customized to present as many or as few user interface controls as necessary so that people can complete their work without distractions.
This chapter introduces Web Access components and operations. This chapter contains the following topics:

- Virtual Infrastructure Web Access Requirements on page 16
- Installing the VMware Virtual Infrastructure Plug-In on page 18
Virtual Infrastructure Web Access
Requirements

VI Web Access System Requirements

PC Hardware
- Standard x86-based computer
- 266MHz processor minimum (500MHz or faster recommended)
- 128MB RAM minimum (256MB or more recommended)
- 20MB (for Windows hosts) or 10MB (for Linux hosts) free disk space to install the VMware Virtual Infrastructure plug-in

Operating Systems
- Windows
  - Windows XP Professional or Windows XP Home Edition with Service Pack 2
- Linux
  - Linux kernel 2.2.14 or higher
  - glibc 2.3.2 or higher
  - XFree86-3.3.6 or higher
  - gtk+2.0 or higher
  - fontconfig (also known as xft)
  - libstdc++5 or higher

VI Web Access Browser Requirements
To access VMware Virtual Infrastructure Web Access, you should be running:
- Internet Explorer 6.0 or higher
- Mozilla Firefox for Microsoft Windows 1.0.7 or higher
- Mozilla Firefox for Linux 1.0.7 or higher
Note: Other browsers are not actively excluded, but we have certified VI Web Access only with the browsers listed above. Please refer to your browser vendor's own documentation for additional requirements. For the best experience, you should make sure your browser includes all of the security and stability updates recommended by its vendor.
Installing the VMware Virtual Infrastructure Plug-In

Configuring Microsoft Internet Explorer
To install the VMware Virtual Infrastructure plug-in:

1. In the Internet Explorer window, enter the Web Access URL:
   https://vmwarehost.yourdomain.com/ui
2. Log in to VI Web Access using the username and password for the server or host
to which you are connecting.
3. Select a virtual machine from the Virtual Machines list.
4. Click the Console tab.

The plug-in will install automatically on some versions of Microsoft Windows. If
prompted, click Install in the pop-up dialog. You may need to refresh your browser
after installing the plug-in.

Configuring Mozilla Firefox for Microsoft Windows
Before you can install the VMware Virtual Infrastructure plug-in for Mozilla Firefox, you
must configure Firefox to trust your Web Access host.

To install the Virtual Infrastructure plug-in:

1. Launch Firefox.
2. In the Firefox window, open the Options control panel. Choose Tools > Options.
3. Click Web Features.
4. Check Allow web sites to install software, then click Allowed Sites.
5. In the Address of web site entry field, type:
   vmwarehost.yourdomain.com
6. Click Allow.
7. Click OK.

To install the VMware Virtual Infrastructure plug-in:

1. In the Firefox window, enter the Web Access URL:
   https://vmwarehost.yourdomain.com/ui
CHAPTER 1 System Requirements and Web Browser Configuration

2. Log in to VI Web Access using the username and password for the server or host to which you are connecting.
3. Select a virtual machine from the Virtual Machines list.
4. Click the Console tab.
5. When you are prompted to install the plug-in, click OK.
6. After the installation is complete, reload the page. Choose View > Reload.

Configuring Mozilla Firefox for Linux

Before you can install the VMware Virtual Infrastructure plug-in for Mozilla Firefox, you must configure Firefox to trust your Web Access host.

To install the Virtual Infrastructure plug-in:
1. Launch Firefox.
2. In the Firefox window, open the Preferences control panel. Choose Edit > Preferences.
3. Click Web Features.
4. Check Allow web sites to install software, then click Allowed Sites.
5. In the Address of web site entry field, type:
   vmwarehost.yourdomain.com
6. Click Allow.
7. Click OK.

To install the VMware Virtual Infrastructure plug-in:
1. In the Firefox window, enter the Web Access URL:
   https://vmwarehost.yourdomain.com/ui
2. Log in to VI Web Access using the username and password for the server or host to which you are connecting.
3. Select a virtual machine from the Virtual Machines list.
4. Click the Console tab.
5. When you are prompted to install the plug-in, click OK.
6. After the installation is complete, reload the page. Choose View > Reload.

If the plug-in does not load:
2. Launch Firefox again.
3. In the Firefox window, enter the Web Access URL:
   https://vmwarehost.yourdomain.com/ui
4. Select a virtual machine from the Virtual Machines list.
5. Click the Console tab.
Chapter 2

Getting Started with Virtual Infrastructure Web Access

This chapter includes the following topics:

- Installing VI Web Access on page 24
- Connecting to Virtual Infrastructure Web Access on page 25
- Logging Out on page 26
- Overview of the Virtual Infrastructure Web Access Default View on page 27
Installing VI Web Access

This section contains information on installing Web Access and provides the following information:

- Installing VI Web Access on ESX Server on page 24
- Installing VI Web Access on VirtualCenter Server on page 24
- Setting VI Web Access Passwords on page 24

Installing VI Web Access on ESX Server

Web Access is automatically installed when ESX Server is installed.

Installing VI Web Access on VirtualCenter Server

Web Access can be installed from the VirtualCenter Server Windows setup package.

Setting VI Web Access Passwords

Administrators must have a valid username and password to access ESX Server hosts and VirtualCenter Servers using VI Web Access. The Password defaults are as follows:

- **ESX Server** — The default user is root. The root password is configured during the installation of ESX Server.
- **VirtualCenter Server** — The default user is Administrator. The Administrator password is configured during the installation of VirtualCenter server.

Administrators can add users and groups to allow users access to VI Web Access.

For more information on setting passwords during installation, refer to the *VMware ESX Server Installation Guide*. 
Connecting to Virtual Infrastructure
Web Access

Once your user name and password are authorized by VI Web Access, the VI Web Access home page appears. The VI Web Access home page contains:

- High level details about all the virtual machines on the server to which you are connected.
- The option to access the details page for a virtual machine where you find information about virtual devices, configuration options and a summary of recent events.

To log in to VI Web Access:

1. Launch your Web browser.
2. Enter the URL of your ESX Server or your VirtualCenter Server installation:
   https://<host or server name>/ui
   The Web Access login page appears.

   The login page contains fields for your user name and password.
3. Enter your username and password, and click Log In.
   The VI Web Access home page appears. For information about the Status Monitor page, see Overview of the Virtual Infrastructure Web Access Default View on page 27.

   To log out of VI Web Access, see Logging Out on page 26.
Logging Out

You can log out from Web Access by clicking the Log Out link found at the upper right corner of every page. You are prompted to confirm that you want to log out. Logging out disconnects client devices that any of the virtual machines are using.
Overview of the Virtual Infrastructure
Web Access Default View

The following sections describe the VI Web Access interface and components and provides the following information:

- Viewing Virtual Machines on page 28
- The Menu Bar on page 29
- The Toolbar on page 31
- The Inventory Panel on page 32

The VI Web Access default view contains a high-level view of the ESX Server or VirtualCenter Server that you are logged into, including a list of all registered virtual machines and their statuses.

Web Access Home Page View

The VMware VI Web Access window is divided into four main sections:

- The Workspace — Appearing on the right, this is the main part of the window. When the host (ESX Server) or a datacenter or folder (VirtualCenter Server) is selected in the inventory panel (see below), you can view a list of all the virtual machines contained by the selected object. When a virtual machine is selected, the workspace provides detailed information about various aspects of the virtual machine.
• The Menu Bar — The menu items along the top of the VI Web Access window provide one-click access to common virtual machine operations, such as power on and enter full screen mode.

• The Toolbar — These buttons along the top allow you to act on your virtual machines, offering one-click options for power, suspend, full screen, and display.

• The Inventory Panel — Appearing on the left, this area displays a list of virtual machines (ESX Server) or the virtual machine hierarchical inventory (VirtualCenter Server). Click a virtual machine to display information about the virtual machine and available options for the virtual machine.

Viewing Virtual Machines

When you select a virtual machine, the Workspace provides detailed information about various aspects of the virtual machine. You can view a summary of the virtual machine’s state, interact with the guest operating system using remote mouse-keyboard-screen (MKS), and view details about alarms (VirtualCenter), events, and tasks (VirtualCenter).

Virtual Machine Information Panel

Note: Administrators can configure a URL for any virtual machine that displays only the remote Console tab, hiding and disabling the workspace tabs and inventory
panel. See Creating and Sharing Remote Console URLs on page 46 for more information.

**The Menu Bar**
The menu bar provides access to all commands.

**Web Access Menu Bar**
The menu bar options are:

- **Web Access Menu** — displays options relevant to VI Web Access.
- **View Menu** — controls which panes are visible.
- **Virtual Machine Menu** — is enabled only when a virtual machine is selected in the Inventory panel or on the host folder summary page.

The Web Access menu bar options are covered in the following sections:

- VI Web Access Menu on page 29
- View Menu on page 30
- Virtual Machine Menu on page 31

**VI Web Access Menu**
The VI Web Access menu lists general Web Access options for getting help and logging off.

**Web Access Menu**

- **About** — displays the Web Access version, the host agent version, and VMware copyright information.
- **Help Menu** — displays the online help contents.
  
  **Note:** The online help is not available in this beta release.
- **Log out** — logs you off VI Web Access.
View Menu
The virtual machine View menu lists options for managing inventory and tab views on the VI Web Access home page.

Inventory View Options
The inventory panel displays a list of inventory objects. Display options include:

- **Expand Sidebar** — expands the inventory panel.
- **Collapse Sidebar** — collapses the inventory panel. When the inventory panel is collapsed, the inventory panel is a strip along side of the VI Web Access window. You can click the arrows in the strip to expand or collapse the inventory panel.
- **Hide Sidebar** — hides the inventory panel. When the inventory panel is hidden, you cannot access the inventory panel unless you deselect this view option.

Virtual Machine Tab View Options
The virtual machine tabs appear at the bottom of the information panel. Display options include:

- **Show Tabs** — displays the Summary, Events, Tasks (VirtualCenter only), Alarms (VirtualCenter only), and Console tabs for the virtual machine.
- **Hide Tabs** — hides the Summary, Events, Tasks (VirtualCenter only), Alarms (VirtualCenter only), and Console tabs for the virtual machine.
Virtual Machine Menu
The Virtual Machine menu lists options for managing the power state of a virtual machine and for viewing the console.

Web Access Virtual Machine Menu
The menu includes the following commands, some of which can be performed using the buttons and other visual elements of the management interface.

Virtual Machine Power Options
- **Shutdown Guest** — shuts down the guest operating system, and powers off the virtual machine.
- **Suspend** — suspends a powered on virtual machine.
- **Power On** — powers on a stopped virtual machine.
- **Resume** — resumes a suspended virtual machine.
- **Restart Guest** — restarts the guest operating system and the virtual machine.
- **Power Off** — powers off the virtual machine immediately. This is the same as turning off the power to a physical computer.
- **Reset** — resets the virtual machine immediately. This is the same as pressing the reset button on a physical computer.

The Toolbar
The toolbar at the top of the VI Web Access page contains buttons you can click to power your virtual machines on and off.
The following table describes the toolbar actions.

<table>
<thead>
<tr>
<th>Button</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Power Off" /></td>
<td><strong>Power Off</strong> — powers off the virtual machine immediately. This is the same as turning off the power to a physical computer. A flashing icon indicates that the virtual machine is in the process of powering off.</td>
</tr>
<tr>
<td><img src="image" alt="Suspend" /></td>
<td><strong>Suspend</strong> — suspends a powered-on virtual machine. You can resume your work later, as if you never left. A flashing icon indicates that the virtual machine is in the process of suspending.</td>
</tr>
<tr>
<td><img src="image" alt="Power On/Resume" /></td>
<td><strong>Power On/Resume</strong> — powers on a stopped virtual machine or resumes a suspended virtual machine. A flashing icon indicates that the virtual machine is in the process of powering on or resuming.</td>
</tr>
<tr>
<td><img src="image" alt="Reset" /></td>
<td><strong>Reset</strong> — resets the virtual machine immediately. This is the same as pressing the reset button on a physical computer. A flashing icon indicates that the virtual machine is in the process of resetting.</td>
</tr>
<tr>
<td><img src="image" alt="Full Screen" /></td>
<td><strong>Full Screen</strong> — enlarges the virtual machine display to cover the entire Web Access window. This option is enabled only when a virtual machine is running and the Console tab is selected.</td>
</tr>
</tbody>
</table>

**The Inventory Panel**

This panel displays the virtual machine inventory. You can collapse and expand the inventory panel with a single click.

**Note:** Administrators can configure a URL that will not show the inventory panel.
CHAPTER 3

Using Virtual Infrastructure Web Access to Manage Virtual Machines

This chapter describes the various aspects of using VI Web Access to manage virtual machines. This chapter contains the following sections:

- The Summary, Events, Alarms, Tasks, and Console Views on page 36
- Viewing Summary Information About Virtual Machines on page 37
- Viewing Virtual Machine Events on page 39
- Viewing Virtual Machine Alarms on page 40
- Viewing Virtual Machine Tasks on page 41
- Using the Console on page 42
- Installing VMware Tools in the Guest Operating System on page 44
- Changing the Power State of a Virtual Machine on page 45
- Creating and Sharing Remote Console URLs on page 46
The Summary, Events, Alarms, Tasks, and Console Views

The workspace, which appears on the right of the VI Web Access display, displays information about the selected virtual machine divided into multiple tabs.

- **Summary** — displays performance and status information. From this tab, you can modify the selected virtual machine’s hardware and configuration options.
- **Events** — displays events that occurred for the virtual machine. Select an event to see its details in the Event Details field.
- **Alarms** — displays alarms. This tab is available through VirtualCenter Server only.
- **Tasks** — displays activities and activity details. This tab is available through VirtualCenter Server only. Tasks may be initiated manually or may be scheduled using the VI client.
- **Console** — Provides a remote mouse-keyboard-screen (MKS) for the selected virtual machine. For more information on connecting the remote MKS, see Using the Console on page 42.
CHAPTER 3 Using Virtual Infrastructure Web Access to Manage Virtual Machines

Viewing Summary Information About Virtual Machines

When you select the Summary tab for a virtual machine, Web Access displays a summary of the configuration information about that virtual machine.

The summary page contains the following information:

- The average amount of server processor capacity that the virtual machine used in the previous five minutes.
- The average amount of server memory that the virtual machine used in the previous five minutes.
• The current power state of the virtual machine — whether it is powered on, powered off or suspended. For more information, see Changing the Power State of a Virtual Machine on page 45.

• The guest operating system installed in the virtual machine.

• VMware Tools status indicating whether or not VMware Tools is installed and running. For more information, see Installing VMware Tools in the Guest Operating System on page 44.

• The IP address and DNS name of the virtual machine.

• Links to edit or remove the virtual machine’s hardware. To change most options, you must power off the virtual machine. For more information, see Editing the Hardware Configuration of a Virtual Machine.

• Links to add hardware to the virtual machine. For more information, see Adding Hardware to a Virtual Machine on page 62.

• Links to edit the virtual machine’s standard configuration options. To change most options, you must power off the virtual machine. For more information, see Changing Virtual Machine Options on page 77.

• Link to create a bookmark of the virtual machine. For more information, see Creating and Sharing Remote Console URLs on page 46.

• The current relationships of the virtual machine — the name of the virtual machine’s host, datastores, and networks.
CHAPTER 3 Using Virtual Infrastructure Web Access to Manage Virtual Machines

Viewing Virtual Machine Events

The Events tab is available when you select a virtual machine from the Inventory panel.

The Events list displays a sorted log of the most recent virtual machine transactions, such as questions ESX Server asks, errors, and other events like the powering on or powering off of the virtual machine. The events appear in reverse chronological order.

The event log draws its data from the log file for the virtual machine’s configuration file stored, by default, in the directory where the virtual machine is stored.

The Events tab content is described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triggered</td>
<td>The date and time the event occurred.</td>
</tr>
<tr>
<td>Triggered By</td>
<td>The entity which triggered the event.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of event that occurred.</td>
</tr>
<tr>
<td>Message</td>
<td>A description of the transaction.</td>
</tr>
</tbody>
</table>
Viewing Virtual Machine Alarms

If you are logged into VirtualCenter Server, the Alarms tab is available when you select a virtual machine from the inventory panel. Alarms are notifications that are triggered when specified events happen to a virtual machine, such as CPU usage exceeding the designated usage.

The Alarms tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last triggered</td>
<td>The date and time the alarm was most recently triggered.</td>
</tr>
<tr>
<td>Status</td>
<td>The severity of the alarm.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the alarm.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the alarm.</td>
</tr>
</tbody>
</table>
CHAPTER 3 Using Virtual Infrastructure Web Access to Manage Virtual Machines

Viewing Virtual Machine Tasks

If you are logged into VirtualCenter Server, the Tasks tab is available when you select a virtual machine from the inventory panel. Tasks are high-level actions, such as powering on a virtual machine, that are performed manually by a user or automatically on a schedule. Click a task’s triggered date and time to display its details, including related events, in the Task Details section.

The Task tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triggered</td>
<td>The date and time the task started.</td>
</tr>
<tr>
<td>Triggered By</td>
<td>The user or entity which initiated the task.</td>
</tr>
<tr>
<td>Status</td>
<td>The state of the task: queued, in progress, error, or success.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the task.</td>
</tr>
</tbody>
</table>
Using the Console

The Console tab is available when you select a virtual machine from the inventory panel. If you need to interact with the guest operating system running in a virtual machine, you can use the Console tab to connect remotely to the virtual machine’s mouse, keyboard, and screen.

When a virtual machine is powered off, suspended, or not available, the Console tab displays a message and possible actions for the virtual machine.

Virtual machine states include:

- **Powered Off** — provides the option to power on the virtual machine.
- **Suspended** — provides the option to resume the virtual machine.
- **Not Available** — provides the option to try again.
When the virtual machine is powered on, the **Console** tab displays the MKS of the virtual machine.

To interact with the guest operating system using your mouse or keyboard, click the virtual machine’s screen. To transfer control of your mouse and keyboard back to your computer, press **Ctrl** + **Alt**. If you have VMware Tools installed on the virtual machine, you can move the cursor in and out of the virtual machine to quickly switch mouse and keyboard control between the virtual machine and your computer.

### Entering Full Screen Mode

When you select the **Console** tab, a full-screen option is also available. You can select this option by clicking on the full-screen mode toolbar button ( ) or by pressing **Ctrl** + **Alt** + **Enter**. This option is enabled only when a virtual machine is running and the **Console** tab is selected.

To exit full screen mode, press and release **Ctrl** + **Alt**.
Installing VMware Tools in the Guest Operating System

VMware Tools is a suite of utilities that improves the performance of guest operating systems and enhances virtual machine management. For best results, we strongly recommend that you install VMware Tools in all of your guest operating systems.

Once your guest operating system is installed on a virtual machine, follow the directions below for installing or upgrading VMware Tools.

Installing VMware Tools

1. In the status section of a virtual machine's summary, choose Install VMware Tools.
2. The VMware Tools installer has been inserted into your virtual machine's CD or DVD drive. Use the console to complete the installation.

   This step connects the virtual machine's CD drive to an installation file on the ESX Server machine or the VirtualCenter server. If autorun is enabled in your guest operating system (the default setting for Windows operating systems), a dialog box appears after a few seconds. It asks if you want to install VMware Tools. Click Install to launch the Installation Wizard.
3. Click the Console tab.
4. Restart the guest operating system when prompted.
   
   **Note:** You must restart the guest operating system to return the CD/DVD drive to its original configuration.

Upgrading VMware Tools

1. In the status section of a virtual machine's summary, click Upgrade VMware Tools.

   The VMware Tools installer has been inserted into your virtual machine's CD/DVD drive. Use the Console to complete the installation.
2. When you are done, click the option **click here to eject the installer**.
CHAPTER 3 Using Virtual Infrastructure Web Access to Manage Virtual Machines

Changing the Power State of a Virtual Machine

Depending upon your permissions, you can use Web Access to change the power state of the virtual machine. To change a virtual machine’s power state, click the button in the toolbar that indicates the desired power state:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✖️</td>
<td>Powers off the virtual machine. Depending on how you have configured the power options for this virtual machine, ESX Server may shut down the guest operating system before powering off the virtual machine (see Changing Power State Options on page 78). When this icon is red, the virtual machine is powered off.</td>
</tr>
<tr>
<td>⚡️</td>
<td>Suspends a running virtual machine or resumes a suspended virtual machine. VMware Tools executes the script associated with this power state change, if any. When this icon is amber, the virtual machine is suspended.</td>
</tr>
<tr>
<td>🟢️</td>
<td>Powers on a stopped virtual machine or resumes a suspended virtual machine. VMware Tools executes the script associated with this power state change, if any. When this icon is green, the virtual machine is running.</td>
</tr>
<tr>
<td>⚤️</td>
<td>Resets the virtual machine. Depending on how you have configured the power options for this virtual machine, ESX Server may shut down the guest operating system before resetting the virtual machine (see Changing Power State Options on page 78).</td>
</tr>
</tbody>
</table>

Note: Shutting down or restarting a guest operating system only works when VMware Tools is installed. Otherwise, the power is turned off or the virtual machine is reset exactly as if you had pushed the power or reset button on a physical machine. For information on installing VMware Tools, see Installing VMware Tools in the Guest Operating System on page 44.
Creating and Sharing Remote Console URLs

Using VI Web Access, you can create a bookmark of a virtual machine using ordinary Web browser URLs. When creating a bookmark, you can customize the VI Web Access user interface controls, or use the bookmark for personal use. Using bookmarks, you can:

• Add the bookmark to a list of favorite Web pages.
• Share the bookmark with one or more other users in an email message.

To create a virtual machine bookmark:

1. In the status section of a virtual machine's summary, click Generate Remote Console URL. The Generate Remote Console URL page displays.

   ![Generate Remote Console URL](image)

2. Choose user interface features. You can hide non-essential controls permanently or temporarily. This allows a bookmark user to concentrate on using the guest operating system.

3. The bookmark should be captured for further use.
• If using Internet Explorer, right-click the hyperlink and select Add to Favorites.
• If using Mozilla Firefox, right-click the hyperlink and select Bookmark This Link.
4. Click Close to return to the Summary tab.
4

Chapter 4

Editing an Existing Virtual Machine’s Configuration

This chapter describes the various aspects of using VI Web Access to configure virtual machines. This chapter contains the following sections:

• Editing the Configuration of Existing Virtual Machines on page 50
• Editing the Configuration of Existing Virtual Machines on page 50
• Adding Hardware to a Virtual Machine on page 62
• Changing Virtual Machine Options on page 77
Editing the Configuration of Existing Virtual Machines

To see more information about a particular virtual machine and to modify its configuration, click the virtual machine from the Inventory panel. The Summary tab displays the activities you can perform when viewing a virtual machine's details. These activities include:

- Editing the Configuration of Existing Virtual Machines on page 50
- Adding Hardware to a Virtual Machine on page 62
- Changing Virtual Machine Options on page 77

**Note:** The virtual machine must be powered off before you can edit most configuration options.

Understanding Virtual Machine Power States

Configuration actions taken upon a virtual machine require that the virtual machine be in specific power states.

Understanding Permissions and Virtual Machines

Access to a virtual machine is based on the permissions you, as a user, are granted to the virtual machine's configuration file. Different permissions let you access virtual machines in different ways. These ways include:

- Browsing virtual machines.
- Interacting with virtual machines.
- Configuring virtual machines.
- Administering virtual machines.

Depending on your permissions and the state of the virtual machine, some options may not be available.

**Note:** Permissions are configured using the Virtual Infrastructure Client. For more information, see the VMware Virtual Infrastructure Management Guide.
CHAPTER 4  Editing an Existing Virtual Machine's Configuration

Editing the Hardware Configuration of a Virtual Machine

The Hardware list on the virtual machine Summary tab lists the virtual hardware in the virtual machine, such as memory, hard disks, CD/DVD drives, and network adapters. You can configure each hardware component, but frequently the virtual machine must be powered off to edit all of the component’s options.

You can configure each virtual hardware component. Network adapters, CD/DVD drives, and passthrough SCSI devices be configured only when the virtual machine is powered off.

Activities you can perform when editing the configuration of a virtual machine’s hardware include:

- Editing Processors on page 51
- Editing or Removing a CD/DVD Drive on page 52
- Editing or Removing a Floppy Drive on page 54
- Editing a SCSI Controller on page 55
- Editing or Removing a Hard Disk on page 56
- Editing Memory Configuration on page 57
- Editing or Removing a Network Adapter on page 58
- Editing or Removing a Parallel Port on page 59
- Editing or Removing a Serial Port on page 60

Editing Processors

You can change the number of virtual processors used by your virtual machine. To change the number of processors used, complete the following steps:

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
4. Click **Edit**. The processor configuration page appears.

   ![Processor Configuration Page]

5. Choose the number of processors you would like for the virtual machine from the **Processor Count** drop-down menu.

6. Click **OK** to save your changes and to return to the Summary tab.

### Editing or Removing a CD/DVD Drive

Virtual machines can access physical CD/DVD drives on either the ESX Server host where the virtual machine is running or on your computer. They can access ISO images on the ESX Server file system.

To remove an existing CD/DVD drive:

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click the CD/DVD drive that you want to remove. The available CD/DVD drive configuration options appear under **Commands**.
4. Click **Remove**.

To edit an existing CD/DVD drive:

1. Select the virtual machine you want to modify from the inventory panel.
2. In the Summary page, click the CD/DVD drive that you want to modify. The available CD/DVD drive configuration options appear under **Commands**.
3. Click **Edit**. The CD/DVD drive configuration page appears.

![CD/DVD Drive Configuration](image)

The media source machine is selected at the top of the dialog box.

- To connect the CD/DVD drive to the ESX Server devices or files, select **Host Media**.
- To connect the CD/DVD drive to devices on your computer, click **Client Media**.

**Note:** The remainder of the dialog box contents change to accommodate the capabilities of the selected media source. For example, virtual machines cannot connect automatically to client media while powering on; consequently, the **Connect at power on** checkbox is disabled if the **Client Media** option is selected.

- To connect this virtual machine to the server's CD/DVD drive when the virtual machine is powered on, check **Connect at power on**.

4. Specify whether to connect to the server's CD/DVD drive or to an ISO image. Select **Physical Drive** or **ISO Image**.

5. Enter the location of the drive or ISO image in the **Physical Drive** field. For example, the server's CD drive could be `/dev/cdrom`.
6. Select the IDE device node from the IDE Device Node list.
7. Click OK to save your changes and to return to the Summary tab.

Editing or Removing a Floppy Drive

Virtual machines can access physical floppy drives on either the ESX Server host or on the computer on which you are running VI Web Access. They can access floppy image files on the ESX Server file system.

To remove an existing floppy drive:
1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click the floppy drive you want to modify. The available floppy drive configuration options appear under Commands.
4. Click Remove.

To edit an existing floppy drive:
1. Select the virtual machine you want to modify from the inventory panel.
2. In the Summary page, click the floppy drive you want to modify. The available floppy drive configuration options appear under Commands.
3. Click Edit. The floppy drive configuration page appears.

4. To connect this virtual machine to the server's floppy drive, check Connected.
CHAPTER 4 Editing an Existing Virtual Machine’s Configuration

Note: Only one virtual machine can connect to the floppy drive on the server at a time.
To connect this virtual machine to the server’s floppy drive when the virtual machine is powered on, check Connect at Power On.

5. Specify whether to connect to the server’s floppy drive or to a floppy image. In the Device list, select Physical Drive or Floppy Image.

6. Enter the location of the drive or floppy image in the location field. For example, the server’s floppy drive could be /dev/fd0.

7. Click OK to save your changes and to return to the Summary tab.

Editing a SCSI Controller
To edit a SCSI Controller’s configuration:

1. Select the virtual machine you want to modify from the inventory panel.

2. On the Summary page, click the SCSI controller you want to modify. The available SCSI controller configuration options appear under Commands.

3. Click Edit. The SCSI controller configuration page appears.

4. Select the SCSI controller type in the list.

Caution: Changing the SCSI controller type may prevent the virtual machine from booting.
5. Specify whether or not the SCSI bus is shared. Depending upon the type of sharing, virtual machines can access the same virtual disk simultaneously on the same server or any server. Select the type of sharing in the SCSI Bus Sharing section.

- **None** — Virtual disks cannot be shared by other virtual machines.
- **Virtual** — Virtual disks can be shared by virtual machines on the same server.
- **Physical** — Virtual disks can be shared by virtual machines on any server.

6. Click **OK** to save your changes and return to the Summary tab.

**Editing or Removing a Hard Disk**

To remove an existing hard disk:

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click the hard disk you want to modify. The available floppy drive configuration options appear under **Commands**.
4. Click **Remove**.

To edit an existing hard disk:

1. Select the virtual machine you want to modify from the inventory panel.
2. On the Summary page, click the hard disk you want to modify. The hard disk options appear under **Commands**.
3. Click **Edit**. The hard disk page appears.

4. Choose to use the disk in **Independent Mode**.

5. Choose the appropriate **Persistent** or **Nonpersistent** disk mode. ESX Server can use disks in two different modes: persistent or nonpersistent.
   - **Persistent** — Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.
   - **Nonpersistent** — Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset.

   Nonpersistent mode is convenient for users who always want to start with a virtual machine in the same state. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.

6. Click **OK** to save your changes and return to the Summary tab.

**Editing Memory Configuration**

To edit memory allocation:
1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click **Memory**. The available memory configuration options appear under **Commands**.
4. Click **Edit**. The memory device page appears.

5. To ensure that the virtual machine will boot, allocate at least the Recommended Minimum memory.
6. Click **OK** to update the memory setting and return to the Summary tab.

**Editing or Removing a Network Adapter**

Virtual network adapters can be connected to a labelled network in much the same way that physical network adapters are connected by cables to wall jacks. By choosing a labeled network for an adapter, you enable the guest operating system to reach the resources of the specified network.

To remove an existing network adapter:

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click the network adapter you want to modify. The available network adapter configuration options appear under **Commands**.
4. Click **Remove**.

To edit an existing network adapter:

1. Select the virtual machine you want to modify from the inventory panel.
2. On the Summary page, click the network adapter you want to modify. The available network adapter configuration options appear under **Commands**.
3. Click **Edit**. The network adapter page appears.

4. To connect this virtual machine to the network when the virtual machine is powered on, check **Connect at Power On**.

   In the **Network Connection** list, select the virtual network device which you want the virtual machine to use.

   In the **Virtual Device** list, select the network driver you want the virtual machine to use. Choose either the **vlance** or **vmxnet** driver.

5. Click **OK** to add the network adapter and return to the Summary tab.

**Editing or Removing a Parallel Port**

To remove an existing parallel port:

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click the parallel port you want to modify. The available parallel port configuration options appear under **Commands**.
4. Click **Remove**.

To edit an existing parallel port:

1. From the VI Web Access client, select the virtual machine.
2. On the Summary page, click the parallel port you want to modify. The available parallel port configuration options appear under **Commands**.
3. Click **Edit**. The parallel port page appears.

![Parallel Port Page](image)

4. Under **Device status**, the default setting is **Connect at power on**. Clear the check box if you want to deselect this setting.
   - If you select **Physical**, use the drop-down list to choose the port that will be used on the end user's host machine.
   - If you select **File**, enter the path and filename, or browse to the location of the file.

5. Click **OK** to save the updated settings and return to the Summary tab.

### Editing or Removing a Serial Port

You can set up the virtual serial port in a virtual machine to use a physical serial port on the host computer. This is useful, for example, if you want to use a modem or a hand-held device in your virtual machine.

To remove an existing serial port:

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click the serial port you want to modify. The available serial port configuration options appear under **Commands**.
4. Click **Remove**.

To edit an existing serial port:

1. Select the virtual machine you want to modify from the inventory panel.
2. On the Summary page, click the serial port you want to modify. The available serial port configuration options appear under **Commands**.
3. Click **Edit**. The serial port page appears.

4. Under **Device Status**, the default setting is **Connect at power on**. Clear the check box if you want to deselect this setting.
   - If you select **Physical**, use the drop-down list to choose the port that will be used on the end user’s host machine.
   - If you select **File**, enter the path and filename, or browse to the location of the file.
   - If you select **Named Pipe**, use the drop-down list to choose the connection options. Under **Near End**, select **Is a server** or **Is a client**. In general, select **Is a server** if you plan to start this end of the connection first.

5. Under **I/O Mode**, select the **Yield CPU on poll** check box, if the kernel in the virtual machine’s guest operating system uses the virtual serial port in polled mode, not interrupt mode.

6. Click **OK** to save the settings and return to the Summary tab.
Adding Hardware to a Virtual Machine

You add virtual hardware to a virtual machine using the VI Web Access’s Add Hardware Wizard. To start the wizard:

1. From VI Web Access, select the virtual machine.
2. From the Summary tab, under Commands, click Add Hardware.

3. Double-click the type of hardware you want to add.
4. Follow the steps in the wizard. The following sections describe how to add virtual hardware to an existing virtual machine:
   - Adding a Hard Disk on page 62
   - Adding a Network Adapter on page 65
   - Adding a CD/DVD Drive to a Virtual Machine on page 66
   - Adding a Floppy Drive on page 69
   - Adding a Serial Port on page 70
   - Adding a Parallel Port on page 73
   - Adding a SCSI Device on page 75

Adding a Hard Disk

Hard disks are the only hardware that you can add to a virtual machine while the virtual machine is powered on. To add a hard disk to a virtual machine, complete the following steps.

1. Select a virtual machine from the inventory panel.
2. From the Summary tab, under Commands, click Add Hardware. The Add Hardware Wizard opens.
3. Double-click **Hard Disk**.

4. Choose the **Disk Type**:
   - **Create a new virtual disk** — creates a new virtual disk and stores it on the host.
   - **Use an existing virtual disk** — finds an existing disk stored on the host.
   - **Use a mapped system LUN** — stores the data directly on a system LUN (logical unit number).

5. Click **Next**.

6. Specify the size and location of the disk. Disk size must be specified in integers only.

7. To install the virtual disk in the same location as the virtual machine, choose to use the virtual machine's datastore.
8. To specify a datastore, type the path to the virtual disk, or click Browse and navigate to the directory you want to use.

9. Click Next.

10. The Advanced Options displays the SCSI device node and disk mode options.

11. Choose to use the disk in Independent Mode.

12. Choose the appropriate Persistent or Nonpersistent disk mode. ESX Server can use disks in two different modes: persistent or nonpersistent.
   - Persistent — Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.
   - Nonpersistent — Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset. Nonpersistent mode is convenient for users who always want to start with a virtual machine in the same state. Example uses include providing known
environments for software test and technical support users, as well as demonstrating software.

13. Review the device configuration summary and click Finish to complete the wizard.

**Adding a Network Adapter**

1. Select a virtual machine from the inventory panel.
2. From the Summary tab, under Commands, click Add Hardware. The Add Hardware Wizard opens.
3. Double-click Network Adapter.
4. Select the network interface card and whether or not the system should connect the device when the virtual machine powers on. Then click Next.

5. Click Finish to add the network adapter.

Adding a CD/DVD Drive to a Virtual Machine

The DVD or CD drives in the virtual machine can be used to read data from DVD or CD disks. You can add up to four DVD or CD drives to your virtual machine. You can connect the virtual machine’s drive to a physical drive or an ISO image on the host machine or to a physical drive on the machine where you are running your browser.

To add a CD/DVD drive to a virtual machine, make sure the virtual machine is powered off, then complete the following steps.

1. Select a virtual machine from the inventory panel.
2. From the Summary tab, under Commands, click Add Hardware. The Add Hardware Wizard opens.
3. Double-click **CD/DVD Drive**.

   ![](image)

   **Media Type**
   CD and DVD media can be accessed on the host system or on your local machine.

   - **Host Media**
     - **Use a physical drive**: Choose this option to give the guest operating system access to a physical CD or DVD drive on the VMware ESX Server system.
     - **Use an ISO image**: Choose this option to give the guest operating system access to an ISO image residing on the VMware ESX Server file system.

   - **Client Media**
     - **Use a physical drive**: Choose this option to give the guest operating system access to a physical CD or DVD drive on your local machine.

4. Choose one of the Media type options:
   - Select **Use a Physical Drive** if you want to connect the virtual machine's drive to a physical drive on the host computer.
   - Select **Use an ISO Image** if you want to connect the virtual machine's drive to an ISO image file.
   - Under **Client Media**, select **Use a physical drive** if you want to connect the virtual machine's drive to a physical drive on your local machine.

5. Click **Next**.

6. If you selected **Use a physical drive**, specify the drive you want to use and indicate whether or not the system should connect the device when the virtual machine powers on.

   ![](image)

   **Drive Selection**
   In order to access the selected media type, a disc must be in the drive specified below, and it must be connected to the virtual machine.

<table>
<thead>
<tr>
<th>Physical Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td>/dev/cdrom</td>
</tr>
</tbody>
</table>

   **Device Status**
   - Connect at power on

7. Click **Next**.
8. If you selected **Client Media Use a physical drive**, specify the drive you want to use.

![Physical Drive](image)

8: 

**Device Status** 

Connect at power on

9. If you selected **Use a ISO Image**, enter the path and filename for the image file or click **Browse** to navigate to the file. To have the drive be connected to the virtual machine when you power it on, check **Connect at power on**.

![Drive Selection](image)

In order to access the selected media type, a disc must be in the drive specified below, and it must be connected to the virtual machine.

**Physical Drive**

Browse...

**Device Status**

Connect at power on

10. Click **Next**. The Advanced Options page appears.

![Advanced Options](image)

These options usually do not need to be changed.

**Virtual Device**

IDE Device Node: 0 0

11. Choose the virtual device from the pull-down menu.

12. Click **Next**. The **Ready to Complete** page appears and displays the device settings.

![Ready to Complete](image)

Please verify that your new hardware is configured appropriately.

**The following device will be added to your virtual machine:**

- **Hardware Type**: CD/DVD Drive
- **Media Type**: Host CD/DVD Drive
- **Media Source**: /dev/cdrom
- **Connected at Power On**: Yes
- **Virtual Device**: 0 0
- **Access Method**: ATAPI Emulation

13. Click **Finish** to add the DVD or CD drive to your virtual machine.
Adding a Floppy Drive

You can connect a floppy drive in your virtual machine to a physical drive or floppy image on the host machine or to a physical drive on your computer. The resource backing a virtual floppy drive can only be connected to one virtual machine at a time.

To add a new virtual floppy drive to a virtual machine, make sure the virtual machine is powered off, then complete the following steps.

1. Select a virtual machine from the inventory panel.
2. From the Summary tab, under Commands, click Add Hardware. The Add Hardware Wizard opens.

3. Double-click Floppy Drive.

4. Choose one of the Media type options:
   - Select Use a physical drive if you want to connect the virtual machine’s drive to a physical drive on the host computer.
• Select **Use an existing floppy image** if you want to connect the virtual machine’s drive to a floppy image file on the ESX Server file system.

• Select **Create a blank floppy image** if you want to connect the virtual machine’s drive to a new, blank floppy image file on the ESX Server file system.

• Under **Client Media**, select **Use a physical drive** if you want to connect the virtual machine’s drive to a physical drive on your local machine.

5. Click **Next**.

6. Select the type of floppy media. To have the floppy drive be connected to the virtual machine when you power it on, check **Connect at power on**.

   **Note:** Connect at power on is not available with client media.

7. Click **Finish** to add the Floppy drive to your virtual machine.

**Adding a Serial Port**

You can set up the virtual serial port in a virtual machine to use a physical serial port on the host computer. This is useful, for example, if you want to use an external modem or a hand-held device in your virtual machine.

To add a serial port to the virtual machine’s configuration, complete the following steps with the virtual machine powered off.

1. Select a virtual machine from the inventory panel.

2. From the Summary tab, under **Commands**, click **Add Hardware**. The Add Hardware Wizard opens.
3. Double-click **Serial Port**. The Serial Port page appears.

4. Choose the connection type.
   - **Use a physical serial port** — connects to a port on the end user’s host machine.
   - **Output file** — sends serial port output to a file on the host computer.
   - **Use a named pipe** — send data from one application in a virtual machine to another application in a different virtual machine on the host computer.

5. Click **Next**.

6. To connect this virtual machine to the host’s serial port when the virtual machine is powered on, check **Connect at power on**. Click **Next**.
7. To connect this virtual machine to the host’s physical port when the virtual machine is powered on, check **Connect at power on**. Click **Next**.

8. Enter the location of the output file or browse for a location in the **Output File** field.

   To connect this virtual machine to the host’s output file when the virtual machine is powered on, check **Connect at power on**. Click **Next**.

9. To specify a named pipe, enter the pipe name.
   - Under **Near End**, select **Is a server** or **Is a client**.
In general, select is a server if you plan to start this end of the connection first.

10. Under I/O Mode, select the Yield CPU on poll check box, as the kernel in the target virtual machine uses the virtual serial port in polled mode, not interrupt mode. Click Next.

11. Click Finish to add the serial port to your virtual machine.

Adding a Parallel Port

Parallel ports are used by a variety of devices, including printers, scanners, dongles, and disk drives.

You can attach up to four parallel ports to a virtual machine. The virtual parallel port can connect to a parallel port, or a file on the host operating system.

To add a parallel port to the virtual machine’s configuration, complete the following steps with the virtual machine powered off.

1. Select a virtual machine from the inventory panel.
2. From the Summary tab, under **Commands**, click **Add Hardware**. The Add Hardware Wizard opens.

3. Double-click **Parallel Port**. The Parallel Port page appears.

4. Specify whether to connect to the host’s physical parallel port or to an output file. In the **Device** list, select **System Parallel Port** or **Output File**. Click **Next**.

5. Enter the location of the device in the Location field. For example, the host’s parallel port could be **LPT1** or **/dev/parport0**.
To connect this virtual machine to the host’s parallel port when the virtual machine is powered on, check **Connect at power on**. Click **Next**.

6. If you selected **Output File**, enter the path and filename in the **Output File** field, or browse to the location of the file.

To connect this virtual machine to the host’s parallel port when the virtual machine is powered on, check **Connect at power on**. Click **Next**.

7. Click **Finish** to add the parallel port.

**Adding a SCSI Device**

1. Select a virtual machine from the inventory panel.
2. From the Summary tab, under **Commands**, click **Add Hardware**. The Add Hardware Wizard opens.
3. In the Add Hardware Wizard, double-click SCSI Device.

4. Under **Physical Device**, use the pull-down menu to select the physical device you want to use.

5. To connect this virtual machine to this SCSI device when the virtual machine is powered on, check **Connect at power on**. Click **Next**.

6. Under **Virtual Device**, select the virtual device node where you want this device to appear in the virtual machine. Click **Next**.

7. Click **Finish** to add the SCSI device.
Changing Virtual Machine Options

Configuration options let you adjust characteristics of the selected virtual machine, such as the virtual machine general settings, power options, and advanced options. The options are described in the following sections:

- Changing General Settings on page 77
- Changing Power State Options on page 78
- Changing Advanced Settings on page 78

Changing General Settings

The Options tab lets you adjust characteristics of the selected virtual machine. You must power off the virtual machine before you can make any changes.

1. In the Summary tab, under Configure Options in the Commands section, click General. The General Options options page appears.

2. To change the display name, type a new name in the Virtual Machine Name field.

3. To change the guest operating system installed on the virtual disk (for example, if you are upgrading the guest operating system), select the new guest operating system from the Guest Operating System list.

4. Click OK to save your changes and return to the Summary tab.
Changing Power State Options

Power state options allow you define actions that occur in various virtual machine power states. You must power off the virtual machine before you can make any changes.

1. In the Summary tab, under Configure Options in the Commands section, click Power. The Power Options page appears.

2. Choose the shutdown option for the virtual machine when the server is shut down. At system shutdown, settings for shutting down virtual machines include: power off the virtual machine and shut down the guest operating system. By default, all virtual machines are powered off when the system shuts down. When VMware Tools is running, the virtual machine shuts down the guest operating system by default.

3. Choose the reboot option for the virtual machine when the server is shut down. At system shutdown, settings for rebooting virtual machines include: reset the virtual machine and restart the guest operating system. By default, all virtual machines are rebooted when the system shuts down. When VMware Tools is running, the virtual machine restarts the guest operating system by default.

4. Choose to run a VMware Tools scripts either: After resuming or Before suspending.

Changing Advanced Settings

To change advanced virtual machine configuration options, complete the following steps. You must power off the virtual machine before you can make any changes.
1. In the Summary tab, under **Configure Options** in the **Commands** section, click **Advanced**. The Advanced Options page appears.

- **Run with debugging information** — runs the virtual machine with debugging information, which is useful to have enabled when you are experiencing problems with this virtual machine. You can then provide this information to VMware support to help troubleshoot any problems you are experiencing.

- **Enable logging** — enables logging for the virtual machine.

- **Disable acceleration** — disables acceleration in the virtual machine. You may want to temporarily disable acceleration in a virtual machine if you try to install or start a particular program in a virtual machine and the program seems to hang, crash, or complain that it is running under a debugger. VMware has seen this problem with a few programs. Generally, the problem occurs early in the program’s execution. In many cases, you can get past the problem by temporarily disabling acceleration in the virtual machine.

This setting slows down virtual machine performance, so it is recommended only for getting past the problem with running the program. After you pass the point where the program was encountering problems, try returning to the virtual machine settings editor and removing the check beside **Disable acceleration**. You may then be able to run the program with acceleration.